Introduction to EndNote Online

Brown Bag Workshops 2014

USU Learning Resource Center
# Table of Contents

What is EndNote®? .......................................................... 3

What is EndNote Online? ........................................ 3
  EndNote vs. EndNote Online: Selecting the Right Tool ......................... 3

The EndNote Online Library ........................................ 5
  Creating your EndNote Online Library ........................................ 5
  Accessing your EndNote Online Library once you have an Account ................ 6
    Re-Authorizing your EndNote Online Account .................................. 7

Reference Management ............................................. 8
  Manually Entering References into a Library .................................... 8
  Organizing citations into Groups ................................................. 9
    Creating Groups ........................................................................ 9
    Adding Citations to a group ....................................................... 9
  Viewing and Editing Individual References in your EndNote library .............. 10
  Searching for References in the EndNote Online Library ......................... 10
  Sharing Groups ....................................................................... 10

Searching remote databases and importing into EndNote Online .................... 12
  PubMed (MEDLINE) .................................................................. 12
  Ovid Databases (Cochrane, MEDLINE, PsycINFO) ................................ 14
  Exporting from Web of Science .................................................. 15

Sync your EndNote Online and Desktop EndNote Libraries ........................ 15

Entering References into a Word Document (Cite While You Write) ............... 16
  Word 2007 and higher .................................................................. 16
    Inserting EndNote Online Citations into Your Paper ............................ 16
    Choosing a Bibliographic Style and Formatting your Document ............... 18

---

**Who can I contact for help?**

The LRC can answer most questions at lrc.ref@usuhs.edu; 301-319-4039. EndNote professional support is available at 800-336-4474 or http://www.endnote.com/support/.

Updated 01/06/2014
What is EndNote®?

EndNote® is a software program, available for Windows and Macintosh, used to manage bibliographic citations. With EndNote you can retrieve references from online bibliographic databases, import them into your own database and create bibliographies in a variety of formats using a word processing program. You can also add references to a paper in Word™, format the references, and create a bibliography using a style of your choosing.

What is EndNote Online?

EndNote Online is a “lite” version of EndNote that stores a user's EndNote library online. Citations can be created, managed, and used from this site in a way similar to the “desktop” version of EndNote.

Basic features available in the free EndNote Online version:

- Stores up to 50,000 references
- Up to 2 GB of attachments
- 21 of the most popular bibliographic styles
- Reference sharing
- Can export references directly from online databases
- Cite While You Write formatting for Microsoft Word

Note: If you have access to Web of Science or Current Contents Connect, additional functionality will be added to your online account. For more information, go to: http://endnote.com/support/faqs/endnote-compare.

EndNote vs. EndNote Online: Selecting the Right Tool

EndNote and EndNote Online are closely related bibliographic management tools with different means of access. Although a traditional EndNote library and EndNote Online library can be "synced" to each other, it is important to understand the features and drawbacks of each program before deciding which tool is best for you and your project.

<table>
<thead>
<tr>
<th>Where is the library saved?</th>
<th>EndNote</th>
<th>EndNote Online</th>
</tr>
</thead>
<tbody>
<tr>
<td>On your PC.</td>
<td></td>
<td>Online. Your EndNote library “lives” on servers owned by Thomson-Reuters, EndNote’s parent company.</td>
</tr>
<tr>
<td>Question</td>
<td>EndNote</td>
<td>EndNote Online</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>How many EndNote libraries may I have?</td>
<td>Unlimited. You may have a separate library for each project or use one library for all of your endeavors and organize individual topics with Groups.</td>
<td>One. You may use the Groups feature to separate your citations into different topics.</td>
</tr>
<tr>
<td>Is web access required to access my library?</td>
<td>No.</td>
<td>Yes.</td>
</tr>
<tr>
<td>How easy is it to share my library with others (e.g. research partners, mentor)?</td>
<td>Not easy. You must convert your library into a compressed format and give group-mates a copy. To update the library it must be redistributed or merged with partners’ copies.</td>
<td>Easier. If each partner has an EndNote Online account, entire groups may be shared. The ability to add, delete, and edit articles may also be given to others.</td>
</tr>
<tr>
<td>How easy is it to import records from databases?</td>
<td>Neither EndNote nor EndNote Online has a clear edge on “ease of import.”</td>
<td></td>
</tr>
<tr>
<td>Is Cite-While-You-Write available?</td>
<td>Yes.</td>
<td>Yes.</td>
</tr>
<tr>
<td>Do I need to visit ARCS to obtain a copy?</td>
<td>Yes.</td>
<td>No.</td>
</tr>
<tr>
<td>Do I need access to the LRC’s ER to get started?</td>
<td>No.</td>
<td>Yes.</td>
</tr>
<tr>
<td>Can I attach Full-text PDFs to each record &amp; use the “Find Full Text” feature?</td>
<td>Yes. But an affiliated EndNote Online account makes the “Find Full Text” feature more efficient.</td>
<td>Yes. If you have linked your EndNote Online account to EndNote X5 or higher, you may attach some PDFs.</td>
</tr>
<tr>
<td>Can EndNote Online and EndNote “talk” to each other?</td>
<td>Yes. EndNote and EndNote Online can transfer records to each other.</td>
<td></td>
</tr>
<tr>
<td>Can I use both EndNote and EndNote Online when writing one paper?</td>
<td>No. You should select either EndNote or EndNote Online when writing your paper.</td>
<td></td>
</tr>
<tr>
<td>How do I update my version?</td>
<td>Generally releases a new version annually which must be installed.</td>
<td>Updated online. You must re-authorize your account annually to retain full privileges.</td>
</tr>
</tbody>
</table>

4
The EndNote Online Library

In EndNote, the term “Library” describes a collection of bibliographic records. Your EndNote Online Library may contain citations to journal articles, books, websites, etc.

Creating your EndNote Online Library

To register for the basic EndNote Online account, you can go directly to endnote.com and click on LOG IN TO ENDNOTE>. Registration by this option, only provides basic and limited functionality.

If you have access to Current Contents Connect or Web of Science, it is recommended that you register for EndNote Online by first accessing one these databases. Creating your account this way will automatically expand functionality of the service.

- To access Web of Science, start from the LRC website, https://lrc.usuhs.edu, and sign in with your LRC ID/Password.
- In the Search Our Collections search box, enter web of science and click Search. Next, click on Web of Knowledge of Web of Science (Figure 1).
- At the top of the Web of Science screen, click the EndNote tab (Figure 2) and Sign In.

Note: The registration page will sometimes have trouble displaying properly. Although it does not appear the same as the figure, it is still a functional page.
New users, you will need to click on **Register** to create an account (Figure 3). You will be asked for your email address, name, a password, and to identify your academic role (e.g. graduate student, researcher, faculty, etc.) and subject area.

- You may wish to “opt-out” of email updates.
- If you are using a shared computer do not select the option to “sign-in” automatically.

After registering you will be returned to the Web of Science homepage. You will need to click on the **EndNote** tab again to enter the program and agree to EndNote Online's User Agreement. This will bring you to your personalized EndNote Online homepage (Figure 4).

Once you have created an EndNote Online account you may re-enter it in one of several ways.

- Visit http://www.myendnoteweb.com
- Use the “EndNote Online” feature in your desktop version of EndNote (e.g. X6 or X7)
- Access **Current Contents Connect** or **Web of Science** via the LRC website, after you sign in with your LRC ID/Password.
Re-Authorizing your EndNote Online Account

Users with access to Web of Science, Current Contents Connect or have the current desktop version, must **re-register** their EndNote Online account annually to retain full privileges.

- To verify if your authorization has expired, log into your EndNote Online account and go to **Options > Account Information**. You should see a screen similar to the one shown below.

![Account Information Screen](image)

- To re-authorize your account, log off EndNote Online. Next, sign in to the LRC website and access EndNote Online via **Web of Science** or **Current Contents Connect**, see page 4.
Reference Management

You will often be able to export references from an online database to EndNote Online. When an import option is not available, though, you may enter records by hand.

Manually Entering References into a Library

- From Collect, click on New Reference. This will display a blank “Generic” reference.
- To change the record type from Generic, select a reference type from the drop down list (Figure 5). The fields provided will automatically adjust to the newly specified reference type (e.g. Web page, Book, Journal article).

![Figure 5: Changing the Reference Type of a New Reference Form](image)

- Fill out the fields for your reference. Each field will “autosave” as you enter it. Formatting tools allow you to italicize genus and species, as needed.
  - Authors must be listed in the format LastName, FirstName although initials for the first and middle name may be used in place of the full name (e.g. Last, F.M.). A semi-colon should separate authors.
  - Not all fields need to be filled. You only need to complete the fields required by your output style.
  - When entering corporate authors (such as Department of Defense or General Electric), put a comma after the name before using the semi-colon.
- Click on the arrow next to Groups at the bottom of the form to select where you’d like your citation to be stored. A citation may be saved in multiple groups.
- When you are finished, simply click on All My References or an individual group to see your entire collection or an entire group.
Organizing citations into Groups

A group defines a subset of references within the library. The Groups feature organizes your EndNote Online library into subject categories.

Creating Groups

- To create a group, click the Organize tab and select Manage My Groups (Figure 6).

![Figure 6: The Organize tab: Manage My Groups and New Group button](image)

Adding Citations to a group

- From an existing group, such as the default All My References, check the box next to the citation(s) you wish to put in a new group (Figure 7).

![Figure 7: Selecting a citation to move to a group.](image)

- Use the drop down list “Add to Group . . .” to select the group the checked item(s) should be moved into. A citation may be placed in several groups.
- Use the “[Unfiled]” group to identify citations that have not been sorted.
Viewing and Editing Individual References in your EndNote library

To view or edit an individual record in your library:

- Use the left-hand Navigation Panel to move to the appropriate group of references (e.g. “All My References”). Figure 8, left.
- Click on any field to edit it.
  - Click **Show Empty Fields** to add new fields to the record. Results will be saved as you type.

![Navigation Panel](image-url)

**Figure 8: An Individual EndNote Reference**

Searching for References in the EndNote Online Library

The Quick Search function on the Navigation Panel allows you to locate references within the entire library or an individual group.

- An author search using this function will find authors who are not the primary author.

Sharing Groups

EndNote Online allows researchers to share their citations with other researchers. These collections are shared at the group level, allowing researchers to share only those parts of their EndNote Online library they choose. Researchers may also designate how much editorial control they wish to give partners. To share groups:

- From the **Organize** tab, click **Manage My Groups**.
- Next, go to **Manage Sharing** next to the group you would like to share (Figure 9).
Figure 9: Manage Sharing

- You will see the email addresses of any individuals already sharing the group. Click **Start Sharing This Group** to add email. Enter the email address of the individual (or individuals) with whom you’d like to share the group and indicate the privileges you want them to have for the group.
  
  - Partners in a shared library may be limited to simply viewing items (“Read-Only” privileges) or be allowed to add, delete, and edit citations (“Read & Write” privileges”).
  
  - When sharing you must use exactly the same email address specified by your partner when he or she created his or her EndNote Online account.

- To add names you may click the button to **Add More**. You may change a partner’s privileges or remove them entirely from a group if you wish (Figure 10).

Figure 10: Manage Sharing for an EndNote Online group

- Once you’ve added all your partners to your group, you must **check** the box next to **Manage sharing** to activate your specifications (Figure 9). Your shared group will be visible on the designated partner’s navigation panel. EndNote Online adds a small icon (ሪ) to indicate that a group in your library is shared.

- If you’ve granted “Read & Write” privileges to a shared group, those group members can update (add, delete or change) contents without your involvement, (Figure 11).
Figure 11: A Shared EndNote Library before (top) and after (bottom) a group member has added items to it.

**Searching remote databases and importing into EndNote Online**

One of EndNote Online’s most powerful features is its ability to import citations directly from databases such as PubMed, CINAHL, PsycINFO, and even Google Scholar.

**PubMed (MEDLINE)**

Search PubMed. Checkmark items you want to import and select **Send To**, and choose **Clipboard** to add items to this temporary folder.
• You may gather many citations on the Clipboard tab. To export your citations in a format that can be read by EndNote or EndNote Online, select the Send To once again. Click on Citation Manager (Figure 12). Your file will be saved as “pubmed_result.txt.” For more instructions on using the Clipboard, please consult the LRC’s handout, *The Power of PubMed.*

![Figure 12: Citation manager format](image)

• Move from your browser’s window for PubMed to your browser’s window for EndNote Online.

• On EndNote Online’s Collect tab, select Import References.

• On the Import References page select the “pubmed-result.txt” file you just saved (Figure 13). In the “filter” drop-down box, select PubMed (NLM). Then indicate which group you would like the imported citations placed into.

• Click the Import button. Your references should now appear in your EndNote library.

![Figure 13: Import Box](image)
Ovid Databases (Cochrane, MEDLINE, PsycINFO).

Other databases have a more straightforward process for importing to EndNote Online. Directions for an Ovid database are shown below.

- Search one of the Ovid databases (Figure 14), select your results by checking the boxes next to each citation, and go to the Results Manager just above your results.
- Click Export.
- On the following screen (Figure 15), choose Export to EndNote, to indicate you’d like the complete reference, and click Export Citations. When prompted to choose an action for the “ovidweb.cgi” file that’s generated, save the file to the desktop rather than opening the results with an application.
- On EndNote Online’s Collect tab, select the option to Import References.
- On the Import References page select the “ovidweb.cgi” file you just saved. In the “filter” drop-down box, select the database name (e.g. PsycINFO), with the note “(OvidSP)”. Then indicate which group you would like the imported citations placed into.
- Click the Import button. Your references should now appear in your EndNote Online library.

Figure 14: Ovid Search Screen

Figure 15: Export Results
Exporting from Web of Science

Because EndNote Online and Web of Science are both owned by Thomson Reuters, the import process between them has been streamlined. To export results from Web of Science to EndNote Online:

- Select your search results in Web of Science.
- Click, at the top of the screen. You may be asked to sign in again.

Sync your EndNote Online and Desktop EndNote Libraries

You can “sync” your EndNote Online to the Desktop version of EndNote X6 or higher. The Sync process includes groups and group associations but does not include group sets, smart groups, and groups within combination groups. This feature allows researchers to take advantage of the mobility and sharing features of EndNote Online without sacrificing the robustness and efficiency of the Desktop version of EndNote. To synchronize citations between EndNote Online and EndNote:

- Open an EndNote library on your desktop machine. You will need to edit/add your EndNote Online sign-on information (email and password) to EndNote Preferences. To do this:
  - Click on Edit, go to Preferences, and select Sync (Error! Reference source not found.). Enter the email address and password you used to register with EndNote Online. Click on Enable Sync to verify your EndNote Online login information, and click OK.

- Click on the “sync icon” to your EndNote Online account to your EndNote desktop. Your EndNote Online groups are synced to the Unfiled Groups on your EndNote Desktop (Error! Reference source not found.).
Entering References into a Word Document (Cite While You Write)

Once you have an EndNote Online library you can use EndNote Online to add citations to your own work. This feature is called Cite While You Write (CWYW).

**Note:** If you do not have EndNote X6 or higher installed on your computer, you can install the Cite While You Write installer for Windows or Mac.

- To do this, click on the **Options** tab and select **Download Installers**.
- The installation instructions and system requirements, including browser requirements will be listed.

**Word 2007 and higher**

You can write your paper in Microsoft Word and add citations as you write.

**Inserting EndNote Online Citations into Your Paper**

Bring up Word. Click the EndNote X6 (or X7) ribbon tab on the right side to access the toolbar (Figure 18; Do not click the References tab).

![Figure 18: Word EndNote Toolbar](image)

- By default, the EndNote ribbon tab connects with a desktop version of EndNote. To change this, click **Preferences** on the far right hand side of the screen (Figure 19).

![Figure 19: EndNote Preferences in Word](image)
• This will bring you to CWYW’s preferences (Figure 20). Move to the **Application** tab, and specify **EndNote Online** from the drop down list. Click **OK**.

• Start typing your paper. When you are ready to insert a citation, click the **Find Citation** icon. Select the appropriate citation and click **Insert** *(Error! Reference source not found.)*.

• If you are working with a very long document (e.g. a Thesis or Dissertation or if you are using Word’s Track Changes feature), you should use **Unformat Citations** to place your citations in EndNote’s default format. These references should look like {Sever, 2004}.
  - To unformat your citations, go to the Bibliography section of the toolbar, and click **Convert Citations and Bibliography**, use the drop down menu and choose **Convert to Unformatted Citation**.
  - To reformat, click **Update citations and bibliography**.
Choosing a Bibliographic Style and Formatting your Document

Once you have finished adding references to your document, you are ready to format your paper in your preferred bibliographic style.

- From the Bibliography section of the EndNote Online Ribbon Tab, go to the style box to choose your bibliographic style (Figure 22). EndNote Online provides several hundred styles to choose from.
- Once you have selected your bibliographic style, highlight it and click OK.
- Your document should now display in the correct format.
- If you have used “Unformat Citations” you may need to click “Update Citations and Bibliography.”

Figure 22: Document with bibliography in Word